
 

 

County TIF Form 
2024 Instructions 

 

These instructions aid in the completion of the County TIF Information Form. If you need additional assistance, 
please contact the Tax Increment Financing (TIF) Division of the Office of the State Auditor (OSA) at 651-296-4716 
or TIF@osa.state.mn.us.  
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What’s New for 2024 
Changes for 2024 are generally minor and for clarity.  

On the TIF Activity Tab, the question for Line 1 has been changed to “Were any new districts or subdistricts 
certified during 2024?” to include the possibility of hazardous substance subdistricts (HSS). For counties that have 
subdistricts, please list the subdistrict separately when reporting new certified districts. Often these will have a 
DOR HSS code of 01.  

On the Distributions-Settlements Tab, the instructions for Line 4 have been changed to note that separate entries 
for subdistricts are preferred. This is not currently required but may be required in the future. 

The instruction document has been updated for these and other minor changes. Most notably, the Alternate File 
Instructions have been edited for clarity, and the Issues Seen in Past Reporting: Pitfalls to Avoid has been 
reorganized by Tab and some tips have been added. 

Please note: Upon opening the Form, the spreadsheet may default to “Protected View” based on your Excel 
settings. If so, a yellow banner will appear at the top of the spreadsheet and you will need to press the “Enable 
Editing” button. This will allow you to view pre-populated data and to proceed with data entry. 

 

  

mailto:tif@osa.state.mn.us
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Issues Seen in Past Reporting: Pitfalls to Avoid 
Below are some tips we offer for submitting the 2024 files based on issues encountered in the past: 

Throughout 
• Do not cut and paste data into the Form. This will disrupt range names and break the import process (even if 

it successfully submitted through SAFES) and you may be asked to redo the form. 
• Do not reformat cells, hide rows, skip rows, or enter notes/headers in a row. This will also break the import 

process (even if it successfully submitted through SAFES) and you may be asked to redo the form. 
• Use drop down options when available rather than attempting to type information. If the needed district or 

answer is not available in the dropdown tables, choose “Not Listed” (where possible) and type all needed 
information in the comments box on the relevant tab. 

• Do not re-use DOR Codes from decertified districts for newly created districts. Follow up with the 
Department of Revenue and the OSA to clarify or correct DOR TIF codes. 

• When entering dates, use m/d/yyyy format. Using a 2-digit year may result in Excel interpreting the date as 
in the wrong millennium.  

• Make use of the comment boxes for any helpful communication. We have seen very helpful comments and 
explanations. 

Home Tab 
• Before submitting the Form, check the Red Messages Table on the Home Tab to see if there are any 

outstanding issues that need to be addressed. The Form will fail to import in SAFES until all red messages 
are cleared. 

TIF Activity Tab 
• Answer all Yes or No questions. 
• Do not leave DOR codes blank when entering new districts. The location and district codes must contain 3 

digits, and the HSS code much contain 2 digits. 
• When reporting a new district’s first distribution of increment on the TIF Activity Tab, the district should be 

selected from the drop-down menu for Column B when entering a new row on that table. If the district is 
not listed in the drop-down menu, please enter the information in the comments box. 

• Enter only the first-half settlement date when reporting districts receiving their first increment on the TIF 
Activity Tab. Do not enter a second date for the 2nd-half settlement. 

• Report all returned increment for the year even though you may have previously confirmed returned 
increment on a Confirmation of Decertified TIF District Form. 

• If there was a correction of error for a district, make sure to email an explanation and documentation of the 
error (and how it was resolved) to TIF@osa.state.mn.us. 

Distribution-Settlements 
• Answer dropdown questions on lines 1 and 2.  
• Enter an amount (entering zero, if none) for all distribution amounts in the Distribution Table. Do not leave 

the January Clean-up column or individual 2024 distribution amounts blank. 
• Enter totals on line 3 of the Distributions-Settlements Tab when submitting the alternate file, but do not 

enter totals when completing the table. (It will automatically sum the data entered on the table and 
discrepancies can be noted in the comments.) 

• Do not report redistributions of returned increment as distributions on the Distributions-Settlements Tab. 
(When it is redistributed it is no longer tax increment.) 

• Do not enter any delinquent tax distributions as separate rows; include those amounts with current 
distributions in a single row. 
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General Instructions 
Availability of the Form 
2024 Forms were posted in SAFES in January 2025. An email will be sent announcing that the Form is available. If 
you do not receive an email or cannot access the Form by January 20th, please contact us at TIF@osa.state.mn.us. 

Downloading the Form 
The 2024 Form can be downloaded from the State Auditor's Form Entry System (SAFES) on the OSA website. In 
SAFES, download the Form by going to the “Forms” tab. Once there, make sure “2024” is selected and click on the 
“County” tab (not the “TIF” tab) to access the Form. You can download the Form and complete it offline. If it is 
your first time logging into SAFES for 2025, you will need to verify your contact information before being able to 
navigate to a different tab. 

If you have any issues with the SAFES process, please check our SAFES Frequently Asked Questions page or contact 
us at TIF@osa.state.mn.us.  

Reporting Requirement / Due Date 
This form is required under the OSA’s statutory authority to collect information from local governments. The 2024 
Form is for reporting TIF activity, distributions, and TIF enforcement transfers in 2024, including cleanup 
settlements in January 2025. The 2024 Form is due March 31, 2025. 

About This Form 
This form: 

1. Collects essential information that enables oversight of the use of tax increment financing (TIF), which can 
help ensure that tax increment is returned to the county auditor for redistribution when appropriate; and 

2. Ensures that accurate transfers of the TIF enforcement deduction are transferred to the State. 

The form is an Excel file containing four tabs (worksheets): the Home Tab, the TIF Activity Tab, the Distributions-
Settlements Tab, and the TIF Enforcement Deduction Tab. The Home Tab provides overview information, a link to 
these instructions, and important reminders; the TIF Activity and Distributions-Settlements tabs allow reporting of 
important information used for oversight purposes; and the TIF Enforcement Deduction Tab is used to identify 
transfers of the TIF enforcement deduction to the State. 

Column and Line References 
References to lines and columns refer to the green labels in the form, not to the Excel lines and columns.  

Form Fields 
The fields in the form are color-coded: 

White  Data entry is expected.  

Yellow  Data is carried over from fields on other tabs and should not be altered.  

Grey  The field is not applicable (which may be contingent on selections in other fields).  

Blue  The field contains a formula that automatically calculates and should not be altered (except as 
instructed for Line 3 of the Distributions-Settlement Tab, if applicable). 

Submitting the Form 
When the Form is completed, return to SAFES and use the “Submit Documents” Tab to upload the Form. Be sure to 
upload it as an “.xlsx” file and not as a PDF. 

If you are sending the alternate file for the Distributions-Settlement Tab, the alternate file should be emailed to 
TIF@osa.state.mn.us after uploading the Form in SAFES. (In the future, we hope to enable you to upload the 
alternate file with the Form.)  

mailto:TIF@osa.state.mn.us
https://safes.osa.state.mn.us/
https://www.osa.state.mn.us/training-guidance/guidance/frequently-asked-questions/?category=safes
mailto:TIF@osa.state.mn.us
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If you have any issues with the SAFES process, please check our SAFES Frequently Asked Questions page or contact 
us at TIF@osa.state.mn.us.  

Home Tab 
The Home Tab contains general information and highlights important notes and instructions. 

The Form cannot successfully upload via SAFES if there are unresolved red messages. To help identify whether all 
red messages have been resolved, there is a table on the Home Tab that shows the count of red messages on each 
tab. Make sure to check that all messages have been resolved prior to upload or the upload will fail. Contact us by 
phone (651-296-4716) or by email (TIF @osa.state.mn.us) if you run into problems resolving the error messages. 

TIF Activity Tab 
The TIF Activity Tab is used for reporting information about:  

• newly-certified districts;  
• dates of actual first distributions of increment (which determines duration limits);  
• the return of increment by development authorities;  
• decertification of districts;  
• enforcement of the Four-Year Knockdown Rule; and  
• correction of errors activity.  

This information helps verify information reported by development authorities on TIF Annual Reporting Forms and 
also provides information not reported by development authorities. If you need to have additional lines displayed 
to fully report any of the information on this tab, please contact the OSA. 

Hazardous substance subdistricts are not expected to be reported on this Tab separate from their associated 
district, but relevant activity for a subdistrict should be noted in the comments box on Line 8. This differs from the 
Distributions-Settlements Tab where reporting a separate line for a subdistrict is acceptable. 

Line 1 – Newly-Certified Districts 
Select “Yes” or “No” from the drop-down menu to answer the question: “Were any new districts or subdistricts 
certified during 2024?” If you answer “Yes,” complete one row of the table for each new district and subdistrict 
certified.  

The first column has a drop-down list of development authorities that are active in the county. If the new district is 
for an authority that is not listed, provide the name of the authority and all the requested data for the district in 
the comment box on Line 8.   

In the second column, provide the name of the district. Use the name or naming elements provided by the 
authority in addition to any code or reference that the county uses to refer to the district. For example, if a county 
uses a code or number to refer to a district (e.g. “1802”) and the authority refers to the district as “TIF 1-2 Acme 
Project,” providing a name such as “TIF 1-2 Acme (1802)” will facilitate better communication. 

In the third column, provide the certification request date of the district in the m/d/yyyy format. 

In the fourth column, provide the date of certification in the m/d/yyyy format. 

The fifth column is optional and is intended to record any county-assigned numbers or codes to identify the 
district, not including Department of Revenue (DOR) codes which are required in the next three columns. This 
column may be left blank if the county does not use its own unique identifiers.  

The last three columns are for the DOR codes. The DOR assigns a three-digit “Location” code associated with the 
development authority. The “District” code must also be three digits, but is assigned by the county rather than by 
DOR. This code must remain the same for the district from year to year and should not be reused from previous 
districts, nor for future districts.  

https://www.osa.state.mn.us/training-guidance/guidance/frequently-asked-questions/?category=safes
mailto:TIF@osa.state.mn.us
mailto:TIF@osa.state.mn.us
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The two-digit “HSS” code is also assigned by the county rather than DOR. This relates to hazardous substance 
subdistricts (HSS). It is often “01” for the record containing the hazardous substance subdistrict and “00” for the 
overlying TIF district or any district that does not have a hazardous substance subdistrict. Please list new 
subdistricts as a separate record on Line 1. 

Refer to the Department of Revenue for more information about DOR codes.  

Line 2 – First Receipt of Increment 
Select “Yes” or “No” from the drop-down menu to answer the question: “Was the 2024 distribution the FIRST 
receipt of tax increment for any districts?” If you answer “Yes,” complete one row of the table for each district that 
received its first increment. This information is very important, because the first receipt of tax increment generally 
determines the maximum duration of a TIF district unless the TIF plan specifies a shorter duration.  

In the first column, select the district from the drop-down menu that combines the development authority name 
and TIF district name for easy identification. If the district is not listed, this may mean that the district failed to be 
identified as a newly-certified district on earlier county reports and was not reported by the authority. If this is the 
case, provide the information and an explanation in the comment box on Line 8. Please note that hazardous 
substance subdistricts will not appear in the dropdown list and first receipt for a subdistrict should be noted in the 
comments box on Line 8 rather than being added on Line 2. 

In the second column, identify the month and year of the distribution in the m/yyyy format. Only report the first 
date; do NOT report both first- and second-half dates on separate lines. 

Line 3 – Return of Tax Increment 
Select “Yes” or “No” from the drop-down menu to answer the question: “Did any districts have tax increment returned 
during 2024?” If you answer “Yes,” complete one row of the table for each district that returned tax increment. 

In the first column, select the district from the drop-down menu that combines the development authority name and 
TIF district name for easy identification. This list contains all known districts (not including hazardous substance 
subdistricts) that have not been decertified for more than a year. If the affected district is not listed, please provide 
the information in the comment box on Line 8. Returns of subdistrict revenues need not be differentiated from the 
associated district, so any return of increment can be listed for the district rather than the subdistrict. 

In the second column, identify the amount of tax increment returned. 

In the third column, identify the date that you received the returned increment using the m/d/yyyy format. 

Line 4 – Decertified Districts 
Select “Yes” or “No” from the drop-down menu to answer the question: “Were any districts decertified 
during 2024?” If you answer “Yes,” complete one row of the table for each district that decertified. Please 
report all decertifications occurring during the year, even if the Confirmation of Decertified TIF District Form 
still needs to be completed. Any time a district is decertified, a development authority must send the county 
a completed Confirmation of Decertified District Form to verify. Counties are responsible for decertifying 
districts at their proper time, whether that be the maximum duration limit; a limit specified in the TIF plan; 
upon notification from the authority or the OSA that the Six-Year Rule applies; or upon receiving a letter 
requesting decertification (using the date specified in the letter or the date the letter was received if not date 
is specified.) (See Minn Stat. § 469.177, subd. 12.) 

In the first column, select the district from the drop-down menu that combines the development authority name 
and TIF district name for easy identification. The decertification of a hazardous substance subdistrict may be noted 
in the comment box on Line 8. 

In the second column, identify the date of decertification using the m/d/yyyy format.  
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Line 5 – Four-Year Rule 
Select “Yes” or “No” from the drop-down menu to answer the question: “Did any districts have parcels removed 
under the Four-Year Rule during 2024?” If you answer “Yes,” complete one row of the table for each district that 
had parcels “knocked down.”  

Note: Enforcement of the Four-Year Rule is a county responsibility. For more information see the County TIF 
Guide, the Statement of Position on the Four-Year Rule, and/or Minn Stat. § 469.176, subd. 6. 

In the first column, select the district from the drop-down menu that combines the development authority name 
and TIF district name for easy identification.  

In the second column, identify the date the parcels were removed using the m/d/yyyy format. 

Line 6 – Correction of Errors 
Line 6 is intended to record a correction of an error as outlined in statute (Minn. Stat. § 469.177, subd. 13). This 
may include an error or mistake that results in the incorrect certification of a district, incorrect decertification of a 
district, failure to certify a district, or an incorrect computation of an increment amount. Line 6 is not meant for 
simple corrections that cause no substantial issues for the district. For example, this would not apply to the 
correction of a certification date when the correction carried no further consequence, but it would apply to adding 
a parcel that was missed during certification.  

To complete this line, select “Yes” or “No” from the drop-down menu to answer the question: “Did the county 
correct any errors under the correction of errors statute during 2024?” If you answer “Yes,” identify each district 
with such a correction in the table. Select the district from the drop-down menu that combines the development 
authority name and TIF district name for easy identification. If the district is not listed, please identify the district in 
the comment box on Line 8. 

Please note that once a correction is made, documentation of the error and the agreed upon correction must be 
provided to both the Commissioner of Revenue and the Office of the State Auditor. Please e-mail documentation 
for each correction of error to tif@osa.state.mn.us. For more information see the County TIF Guide, the Statement 
of Position on Correction of TIF Errors, and/or the statute. 

Line 7 – County Administrative Costs 
Select “Yes” or “No” to answer the question: “Does this county charge for TIF administrative costs?” This 
information is collected purely for informational purposes. Counties are authorized to charge development 
authorities for the county’s costs incurred in administering the districts. The OSA appreciates having this 
information to verify costs reported by authorities and to respond to inquiries about how many counties are using 
this authority. (See Minn Stat. § 469.177, subd. 12.) 

Line 8 – Comments 
Use this line to provide any comments or notes regarding information reported on this tab. This might include 
identifying authorities and districts not listed in drop-downs or mentioning prior-year activity that was left off of a 
previous report. Also, feel free to contact the OSA with any questions or explanations by email (TIF@osa.state.mn.us). 

Distributions-Settlements Tab 
The Distributions-Settlements Tab is used for reporting the distribution or settlement of tax increments to 
development authorities for each TIF district.  

Line 1 – Distributions to Report 
Select “Yes” or “No” from the drop-down menu to answer the question: “Did this county make any TIF 
distributions/settlements in 2024?” A few counties have no tax increment districts that receive increment and can 
answer “No,” which allows the rest of the tab to be skipped. All others should answer “Yes.” 

Line 2 – Reporting Choice 

https://www.osa.state.mn.us/training-guidance/guidance/tif-county-guides/
https://www.osa.state.mn.us/training-guidance/guidance/tif-county-guides/
https://www.osa.state.mn.us/media/yxtfn31x/tif_fouryearknockdownrule_1105_statement.pdf
https://www.osa.state.mn.us/training-guidance/guidance/tif-county-guides/
https://www.osa.state.mn.us/media/h04pfn2t/correction_of_tif_errors.pdf
https://www.osa.state.mn.us/media/h04pfn2t/correction_of_tif_errors.pdf
mailto:TIF@osa.state.mn.us


2024 County TIF Information Form Instructions   7 

There are two options for reporting: 

1. Complete the full Distributions-Settlements Tab and provide the distribution information in the Distribution 
Table on Line 4 (which has been partially prepopulated to reduce the amount of data entry); or 

2. Generate and submit an alternate file in the specified format. If you are choosing this option, complete only 
Lines 1-3 on this tab and do not complete the table on Line 4. Please skip the instructions regarding Line 4, 
and refer instead to the “Alternate File Instructions” on page 8. 

Select “Table” or “File” from the drop-down menu to indicate whether the county is choosing to complete the 
Distribution Table on Line 4 or submitting the alternate file.  

Line 3 – Totals 
If you choose to complete the Distribution Table on Line 4, the totals on Line 3 will automatically calculate from 
data entered from the distribution table so totals should not be entered. (Use the comment line to explain any 
discrepancies.) If the alternate file is submitted, enter the corresponding totals in columns A and B. Column C will 
automatically calculate the sum of those two amounts. 

Line 4 – Distribution Table 
Note: Please do NOT copy and paste data into this table. This will prevent data from being imported into our 
system by disrupting invisible references in the form. 

Complete one row for each tax increment district that received a distribution of increment in 2024 (or multiple 
rows if there are multiple combinations of the Department of Revenue codes for a district in Columns E-G). 
Districts will be populated for all active districts known to the OSA (the county may be aware of new districts 
before the OSA). This will include districts that have not yet received their first increment and decertified districts 
that are still actively reporting to the OSA. 

If a TIF district spans more than one unique taxing area (UTA) and is maintained in the county system as multiple 
records, the table may include one row for each UTA with the code information repeated for each row. This is also 
true of districts such as housing replacement districts where different modifications are handled in the county 
system as separate records. One record per district, however, is preferred. 

Hazardous Substance Subdistricts (HSS) should be reported as separate rows. 

Previously reported data will be “prepopulated”, or automatically filled in on the form. This should leave Columns 
H and I as the main columns requiring entry. Districts will be populated if they are known and active districts that 
have had their first receipt of increment. Columns E, F, and G pertaining to the DOR codes are locked for pre-
populated rows. If you notice any errors in these columns, please contact the TIF Division or note the issue in the 
comment box on Line 5. 

New rows will need to be added for districts when they receive their first distribution. Add new districts starting 
with the first blank (unpopulated) row. Column B contains a drop-down list of all known districts that have not 
been decertified for more than a year. Previously-decertified districts and some new districts might not be listed. If 
a district does not appear in the dropdown list of districts in Column B, use the choice “Not Listed” and enter a 
descriptive name in Column C for the district. Complete all required columns for each district added. 

Do not skip blank rows and do not enter subtotals, or any extra information on blank rows. 

If you need additional rows to be displayed, please contact the OSA at TIF@osa.state.mn.us. 

Column A – Development Authority Name 
The name of the development authority will be prepopulated. As noted above, if a district is receiving a 
distribution for the first time and needs to be added, use the drop-down menu in the cell with the first blank row 
to select the authority. If an authority is not listed, identify the authority, district name, codes, and distribution 
information for that district in the comments box on Line 5. 

Column B – OSA TIF District Name 
The name of the district, as reported by the authority and maintained by the OSA, will be prepopulated. As noted 
above, if a district is receiving a distribution for the first time and is being added on a new row, select the district 
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from the drop-down menu. If the district is not included in the drop-down menu (which includes all known districts 
that have not been decertified for more than a year), select “Not Listed” (Make sure to enter a descriptive name in 
Column C for the district)  

Column C – County TIF District Name 
This column is optional, except when “Not Listed” is chosen in Column B. The naming of districts in county systems 
may not always match the names used by the OSA. If you wish to populate this column to allow for easier 
reference each year, the OSA will prepopulate the name in future years to enable this efficiency. Having both 
names assists communication between counties, the OSA, and authorities. 

Column D – County TIF Code 
This column is optional. Some counties assign codes (other than those codes used for DOR reporting and shown in 
Columns E – G) to their TIF districts and primarily use this code when working with TIF district data. If you wish to 
populate this column to allow for easier reference each year, the OSA will prepopulate the code in future years to 
enable this efficiency. Including the code may also assist communication between counties, the OSA, and authorities. 

DOR TIF Codes (Columns E-G) 
Columns E, F, and G are used for reporting the codes used to report TIF information to the Department of Revenue 
(DOR). These codes allow the OSA to match information in this form with information provided by the DOR. It serves 
as a standardized coding system: the County TIF Code is not standardized across the DOR, OSA, and counties. 

Provide any missing codes; do not leave blanks. As noted below, the Location code is assigned by the DOR, 
whereas the District and HSS codes are county-assigned but are used for DOR reporting and are to remain 
consistent each year. Refer to the Department of Revenue for more information about these codes.  

Column E – DOR Location Code  
This column is for reporting the DOR-assigned, three-digit “Location” code associated with the development 
authority. If the code is not populated for the district, enter this code. 

Column F – DOR District Code  
This column is for reporting the three-digit “District” code that the county assigns and uses when reporting TIF 
information to the DOR. This code must remain the same for each district from year to year and should not be 
reused for other districts after the first district to use the code decertifies. (To clarify or correct reused codes, 
contact the OSA and Revenue.) If the code is not populated for the district, enter this code. 

Column G – DOR HSS Code  
This column is for reporting the two-digit “HSS” code that the county assigns to distinguish records for a Hazardous 
Substance Subdistrict. It is often “01” for the record containing the hazardous substance subdistrict and “00” for 
the overlying TIF district or any district that does not have a hazardous substance subdistrict. If the code is not 
populated for the district, enter this code. 

Column H – 2024 Distributions  
Enter the total amount of tax increment distributed for each TIF district in 2024, including any delinquent taxes 
paid in 2024, but excluding any cleanup settlement in January 2024. Do not include the TIF enforcement deduction 
amounts in this table. These amounts are transferred to the State and are not distributed to development 
authorities or the districts. Do not include redistributions of tax increment returned to the county auditor by 
authorities as those redistributions are no longer tax increment. 

Column I – January 2025 Clean-up Distributions 
Enter the total amount of tax increment distributed for each TIF district as part of any cleanup settlement in 
January 2025. 

Column J – Total TIF Distributions 
This column is automatically calculated as the sum of Columns H and I. 
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Line 8 – Comments 
Use this line to provide any comments or notes regarding information reported on this tab. 

Alternate File Instructions 
Counties may, for efficiency purposes, generate and submit their own file in the format specified below in lieu of 
completing the table on Line 4. This may be preferable if the county’s system is able to export such a file or 
generate a query that enables the data to be easily copied and pasted into such a file. The optional file is largely 
intended for counties with dozens or hundreds of districts. Counties with fewer districts are encouraged to 
complete the table.  

If a county chooses to submit an alternate file, the file must meet the following requirements: 

• The file must be in comma-separated-values format (with a “.CSV” extension). One way to create a .CSV file 
is to copy and paste the data into an Excel file; select Save As from the File menu; name the file and choose 
a file location; and select .CSV from the drop-down of file types.  

• The file must contain the information in Columns A through I (J Should be excluded) from the Distribution 
Table on Line 4, arranged in the same order as the table. It must not contain any extra columns, headers, 
labels, or text. 

• The authority names and TIF district names can be reported as they are identified in the county system, with 
the TIF district names placed in Column C (Column B should be left blank). The names do not need to 
match the prepopulated Distribution Table, nor do they need to be in the same order as the prepopulated 
Distribution Table. 

Optional columns must be included even if they are not populated. (They should be blank columns in the file 
exported by your system.) For example, if a county leaves Columns B and D blank (after reviewing the instructions 
for those columns), and had no January cleanup distributions, a record in its file might look like this: 

Spruce EDA,,TIF 1-1 Loon Industries,,321,101,00,6329, 

In the above example, the consecutive commas before and after the district name indicate blanks for Columns B 
and D and the blank space after the last comma represents Column I. 

Once completed, submit the 2024 County Form through SAFES, and e-mail the CSV file to TIF@osa.state.mn.us. 

Hint: Excel can be used to create a proper CSV file. If your system allows the output of an Excel file, or if you can 
copy and paste the data into an Excel file, you can manipulate the file, if necessary, to add or remove columns 
so it matches the Line 4 Distribution Table. An Excel file can be saved as a CSV file by choosing the CSV format 
when selecting “Save As.”  

Important: Do not include a header row of column names in the file. Do not add any extra columns, rows, 
subtotals, totals, or text. For example, do not include Column J, which our system will automatically calculate. Do 
not change the meanings of Column H or I. For example, do not skip the cleanup column and provide the total 
instead. Do not break out separate records for delinquent distributions. 

If you have questions about the alternate file or have other alternate formats you would like to see available in the 
future, please contact the TIF Division, at TIF@osa.state.mn.us or 651-296-4716. 

TIF Enforcement Deduction Tab 
The TIF Enforcement Deduction Tab is used for reporting the payment of enforcement deduction amounts to the 
State. The TIF Enforcement Deduction is required under Minn. Stat. § 469.177, subd. 11, and is equal to 0.36% of 
any increment distributed to an authority. The deduction funds the TIF oversight activities of the OSA and is 
remitted to Minnesota Management and Budget (MMB). Each year, some of these payments seem to be missed or 
misdirected. This reporting helps to ensure that these funds are properly transmitted. It is also very important to 
submit the appropriate monthly remittance report to the MMB Treasury Division when making transfers or 
payments, as failing to do so results in significant follow up to identify and properly route the funds. 

mailto:TIF@osa.state.mn.us
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Line 1 – Expected Enforcement Deduction Amount 
Line 1 serves as a reference and automatically calculates the expected amount of TIF enforcement deduction 
based on the total increment distributions reported on Line 3 of the Distribution-Settlements Tab. No entry of 
information is needed in this section.  

The total from the Distribution-Settlements Tab is carried over into Line 1, Column A. The distributed amount 
totaled in Column A should be the amount after the TIF enforcement deduction was removed. Dividing the Column 
A amount by 1-.0036 (0.9964) computes the total tax increment before the enforcement deduction was taken out. 
This is displayed in Column B. Column C then multiplies the total tax increment by the enforcement deduction 
percentage to calculate the amount expected to equal the enforcement deduction. 

If the information in this section looks incorrect, please make a comment on Line 3. 

Line 2 – Enforcement Deduction Payments to the State (MMB) 
On Line 2, enter the amounts and dates of each payment or transfer of TIF enforcement deduction amounts to the 
State. This should generally include transfers from February 2024 through January 2025, and which relate to tax 
increment distributions for the 2024 tax year.  

Typically, only two or three transfers are expected (one for each settlement date), but additional rows are 
provided as some counties have made more frequent transfers. If more than eight transfers were made, please 
combine the remaining amounts on row 8 and note the additional dates in the comment box on Line 3. 

Enter the amounts in Column A and the dates in Column B. The total of amounts listed in Column A is 
automatically calculated and should be compared to the expected total from Line 1, Column C. Minor differences 
due to rounding may occur. However, please explain any differences greater than minor rounding errors in the 
comment box on Line 3. 

Line 3 – Comments 
Differences between the sum of Line 2 and the expected amount on Line 1, Column C, should be explained in the 
comment box. You may also use this line to provide any notes regarding information reported on this tab. 
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